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1. Penting

Buku petunjuk elektronik ini ditujukan untuk
siapapun yang menggunakan monitor Philips.
Luangkan waktu untuk membaca panduan
pengguna sebelum menggunakan monitor. Panduan
tersebut berisi informasi dan catatan penting
tentang cara mengoperasikan monitor:

Jaminan Philips berlaku pada produk yang
penggunaannya ditangani dengan baik sesuai
dengan petunjuk pengoperasian dan atas
presentasi faktur asli atau resi yang menunjukkan
tanggal pembelian, nama dealer, nomor model, dan
nomor produksi produk.

1.1 Tindakan pencegahan dan pemeliharaan

(D Peringatan

Penggunaan kontrol, penyesuaian, maupun
prosedur selain yang dijelaskan dalam dokumentasi
ini dapat mengakibatkan sengatan listrik, bahaya
listrik, dan/atau bahaya mekanis.

Baca dan ikuti petunjuk ini saat menyambungkan
dan menggunakan monitor komputer.

Pengoperasian

* Jauhkan monitor dari sinar matahari langsung,
sinar terang yang sangat kuat dan jauhkan dari
sumber panas lainnya. Terpapar ke lingkungan
seperti ini dalam waktu yang lama dapat
mengakibatkan monitor memucat dan rusak.

* Pindahkan objek apapun yang dapat jatuh
ke lubang ventilasi atau mungkin mencegah
pendinginan elektronik yang benar pada
monitor.

* Jangan halangi lubang ventilasi pada kabinet.

* Saat menetapkan posisi monitor, pastikan
konektor daya dan stopkontak mudah
dijangkau.

* Jika mematikan monitor dengan melepaskan
kabel daya atau kabel daya DC, tunggu selama
6 detik sebelum memasang kabel daya atau
kabel daya DC untuk pengoperasian biasa.

*  Selalu gunakan kabel daya yang disetujui dan
disediakan oleh Philips. Jika kabel daya tidak
ada, hubungi pusat layanan setempat. (Lihat
Pusat Informasi Layanan Pelanggan)

* Jaga agar monitor terhindar dari getaran
kencang atau kondisi berbahaya lainnya selama
pengoperasian berlangsung.

* Jaga agar monitor tidak terjatuh atau terbentur
selama pengoperasian atau pengiriman.

Pemeliharaan

*  Untuk melindungi monitor dari kemungkinan
kerusakan, jangan tekan panel monitor telalu
keras. Saat memindahkan monitor, pegang
bingkai untuk mengangkat, jangan angkat
monitor dengan meletakkan tangan atau jari
pada panel monitor.

* Lepas sambungan monitor jika Anda tidak akan
menggunakannya dalam waktu lama.

* Lepas sambungan monitor jika Anda akan
membersihkannya dengan kain yang lembab.
Layar dapat dibersihkan dengan kain yang
kering saat dimatikan. Namun, jangan pernah
gunakan larutan organik, seperti alkohol
atau cairan beramonia untuk membersihkan
monitor.

*  Untuk menghindari risiko sengatan listrik
atau kerusakan permanen, jangan biarkan
monitor terkena debu, hujan, atau air, maupun
berada dalam lingkungan dengan kelembaban
berlebihan.

* Jika monitor basah, segera seka dengan kain
kering.

* Jika benda asing atau air masuk ke dalam
monitor, segera matikan daya dan lepas kabel
daya. Setelah itu, keluarkan benda asing atau
air tersebut, lalu bawa ke pusat pemeliharaan.

* Jangan simpan atau gunakan monitor di lokasi
yang bersuhu panas, terkena sinar matahari
langsung, atau bersuhu sangat dingin.

*  Untuk memelihara performa terbaik monitor
dan memperpanjang masa pakainya, gunakan
monitor di lokasi dalam kisaran suhu dan
kelembaban berikut.

o Suhu:0-40°C 32-95°F
o Kelembaban: 20-80% RH



Informasi Penting untuk gambar Burn-in/Ghost

* Aktifkan selalu program screensaver bergerak
bila Anda meninggalkan monitor: Aktifkan
selalu aplikasi refresh layar berkala jika monitor
akan menampilkan konten statis yang tidak
berubah. Tampilan gambar diam atau gambar
statis yang tidak berubah dalam waktu lama
dapat menimbulkan “‘efek terbakar”, disebut
juga “jejak gambar” atau “bayangan”, di layar.

»  "Efek terbakar","jejak gambar", atau "bayangan”
adalah fenomena umum dalam teknologi panel
monitor. Dalam sebagian besar kasus, ‘efek
terbakar”, “jejak gambar', atau “bayangan” akan
menghilang secara bertahap dalam waktu
tertentu setelah daya dimatikan.

€ Peringatan

Kegagalan untuk mengaktifkan screen saver, atau
aplikasi penyegaran layar secara berkala dapat
mengakibatkan gejala “burn-in" atau “‘after-image/
bayangan” atau “ghost-image/bayangan semu”.
Kerusakan yang disebutkan di atas tidak tercakup
dalam jaminan.

Layanan

*  Penutup casing hanya dapat dibuka oleh teknisi
ahli.

* Jika harus memperbaiki atau mengintegrasi
dokumen, hubungi pusat layanan setempat.
(lihat bab "Pusat Informasi Konsumen")

*  Untuk informasi pengiriman, lihat "Spesifikasi
Teknis".

* Jangan tinggalkan monitor di dalam mobil/
bagasi di bawah sinar matahari langsung.

© Catatan

Hubungi teknisi servis jika monitor tidak beroperasi
secara normal atau Anda tidak yakin dengan
prosedur yang harus dilakukan bila petunjuk
pengoperasian yang diberikan telah diikuti.

1.2 Keterangan Penulisan

Subbab berikut menjelaskan konvensi penulisan
yang digunakan dalam dokumen ini.

Catatan, Perhatian, dan Peringatan

Dalam buku petunjuk ini, beberapa teks mungkin
disertai ikon dan dicetak dengan huruf tebal atau
miring. Teks tersebut berisi catatan, perhatian, atau
peringatan yang digunakan sebagai berikut:

© Catatan

lkon ini menunjukkan informasi penting dan tips
yang akan membantu Anda memanfaatkan sistem
komputer dengan lebih baik.

@ Perhatian

lkon ini menunjukkan informasi yang
memberitahukan Anda tentang cara menghindari
kemungkinan kerusakan perangkat keras atau
hilangnya data.

(D Peringatan

lkon ini menunjukkan kemungkinan cedera

dan memberitahukan Anda tentang cara
menghindarinya.

Beberapa peringatan mungkin ditulis dalam format
lain dan mungkin tidak disertai dengan ikon. Dalam
hal ini, penulisan peringatan tertentu diwajibkan
oleh peraturan pemerintah terkait.



1.3 Pembuangan produk dan materi kemasan

Waste Electrical and Electronic Equipment-
WEEE

This marking on the product or on its packaging
illustrates that, under European Directive 2002/96/
EC governing used electrical and electronic
appliances, this product may not be disposed

of with normal household waste.You are
responsible for disposal of this equipment through
a designated waste electrical and electronic
equipment collection. To determine the locations
for dropping off such waste electrical and
electronic, contact your local government office,
the waste disposal organization that serves your
household or the store at which you purchased
the product.

Your new monitor contains materials that can be
recycled and reused. Specialized companies can
recycle your product to increase the amount of
reusable materials and to minimize the amount to
be disposed of.

All redundant packing material has been omitted.
We have done our utmost to make the packaging
easily separable into mono materials.

Please find out about the local regulations on how
to dispose of your old monitor and packing from
your sales representative.

Recycling Information for Customers

Your display is manufactured with high quality
materials and components which can be recycled
and reused.

To learn more about our recycling program please
visit www.philips.com/about/sustainability/recycling.




2.Memasang monitor

2.1 Pemasangan

Kl Isi kemasan

VGA (optional) DVI (optional)

E1 Memasang dudukan dasar

1.

3.

Letakkan monitor menghadap ke bawah pada
permukaan yang halus dan lembut agar layar
tidak tergores atau rusak.

Pasang tiang alas hingga terpasang dengan
benar

Pegang dudukan dasar monitor dengan kedua
tangan dan masukkan dudukan dasar dengan
kuat ke dalam batang dudukan.




El Menyambungkan ke PC 2.2 Mengoperasikan monitor

El Keterangan produk bagian depan

PHILIPS

PHILPS 00000

© Input daya AC

® InputVGA

© Input DVI-D 220V3/220V3L

O Kunci antipencurian Kensington

© Input audio (tersedia untuk model °

tertentu)
FUCYA 4 /A o/ < /0K [0)
| | / N\ |
Menyambung ke PC o ° 60 o 0

1. Sambungkan kabel daya dengan kuat ke

bagian belakang monitor. 220V3A/220V3LA
2. Matikan komputer dan lepas kabel daya.
3. Sambungkan kabel sinyal monitor ke 53
konektor video di bagian belakang B )
YA 4 W/ A ©f < /0K [0)
komputer. | | /N | [
4. Sambungkan kabel daya komputer dan o 6 o0 6 o
monitor ke stopkontak di sekitar.
5. Hidupkan komputer dan monitor. Jika
monitor menampilkan gambar; berarti : :
pemasangan telah selesai. o o Untuk mehghldupkan dan mematikan
daya monitor:
O | /0K |Untuk mengakses menu OSD.
O <« Kembalike tingkat OSD sebelumnya.
O & |Menyesuaikan tingkat kecerahan.
©| A V¥V Untuk menyesuaikan menu OSD.
o @  |Mengganti format tampilan.
1l  |Mengatur volume tampilan.
0 AUTO Secara otomatis menyesuaikan
monitor.




E1 Keterangan On Screen Display

Apakah yang dimaksud dengan OSD (On-Screen
Display)?

OSD (On-Screen Display) adalah fitur yang
terdapat pada semua monitor Philips. Pengguna
akhir dapat menggunakannya untuk menyesuaikan
performa layar atau memilih fungsi monitor
secara langsung melalui jendela petunjuk di

layar. Antarmuka tampilan di layar yang mudah
digunakan muncul seperti di bawah ini:

220V3/220V3L

I VGA
nput
£ DvI

Picture

Color

VGA
Input =

Language

Petunjuk dasar dan mudah pada tombol kontrol

Dalam OSD yang ditunjukkan di atas, pengguna
dapat menekan tombol w 4 di bezel depan
monitor untuk memindahkan kursor, OK untuk
mengkonfirmasi pilihan atau perubahan.

Menu OSD

Berikut adalah tampilan keseluruhan dari struktur
On-Screen Display. Anda dapat menggunakannya
sebagai referensi bila ingin melakukan penyesuaian
lainnya nanti.

Sub menu

[ VGA

DVI (available for selective models)

Main menu

— Input

Picture Format — Wide Screen, 4:3
— Picture

Brightness — 0~100

Contrast — 0~100

SmartContrast — On, Off

|— Audio (available for selective models)
Stand-Alone —  On, Off
Mute On, Off

sRGB

User Define Red: 0~100
E Green: 0~100
Blue: 0~100

— English . Espafiol, Frangais, Deutsch, Italiano,

Color Temperature — 650K, 9300K
— Color E

|— Language

Portugués, Pycckuii, AL, Tirkce

r— Horizontal — 0~100
|— OSD Settings
— Vertical — 0~100
— Transparency — Off,1,2,3,4
— OSD Time out — 55,105,205,305,60 s
— Setwp — Auto
— H. Position — 0~100
— V. Position — 0~100
— Phase — 0~100
— Clock — 0~100
[~ Resolution Notification — On, Off
— Reset — Yes, No
L— Information




El Pemberitahuan resolusi 2.3 Melepas Dudukan dan Dudukan Dasar

Monitor dirancang untuk memberikan performa El Melepas Dudukan Dasar
optimal pada resolusi aslinya, 1680%1050 pada
60Hz. Bila monitor dihidupkan pada resolusi yang ~ Sebelum mulai membongkar penyangga monitor;

berbeda, layar akan menampilkan peringatan: ikuti petunjuk di bawah ini agar terhindar dari
Gunakan 1680%1050 pada 60Hz untuk hasil kerusakan atau cedera.

terbaik.

Tampilan peringatan resolusi asli dapat 1. Letakkan monitor menghadap ke bawah pada
dinonaktifkan dari Setup (Konfigurasi) dalam menu permukaan yang halus agar layar tidak tergores
OSD (On Screen Display). atau rusak.

Bl Fungsi Fisik

Kemiringan

2. Tekan klip pengunci untuk melepas penyangga
alas dari tiang alas.

3. Tekan tombol pelepas untuk melepas kolom
alas.




E1 Melepas dudukan

1. Anda dapat menggunakan obeng minus untuk
menancapkan ke dua lubang pelepasan pada
penutup engsel dan pelan-pelan bongkar
penutup tersebut untuk melepasnya.




3. Pengoptimalan Gambar

3.1 SmartContrast

El Apakah yang dimaksud dengan
SmartContrast?

Teknologi unik yang secara dinamis menganalisis
konten yang ditampilkan serta secara otomatis
mengoptimalkan rasio kontras monitor untuk
kejernihan visual dan kenyamanan tampilan
maksimal dengan menambah cahaya lampu latar
agar gambar lebih jernih, tajam, dan terang, atau
mengurangi cahaya lampu latar untuk tampilan
gambar yang jelas di latar belakang gelap.

E1 Mengapa saya memerlukannya?

Anda menginginkan kejernihan visual dan
kenyamanan tampilan terbaik untuk setiap jenis
konten. SmartContrast secara dinamis mengontrol
kontras dan menyesuaikan cahaya lampu latar agar
gambar dalam permainan serta video lebih jernih,
tajam, dan terang, atau menampilkan teks yang jelas
dan mudah dibaca untuk pekerjaan kantor. Dengan
mengurangi pemakaian daya monitor; Anda
menghemat biaya untuk daya dan memperpanjang
masa pakai monitor:

El Bagaimana prosedurnya’

Saat diaktifkan, SmartContrast akan menganalisis
konten yang ditampilkan secara real time untuk
menyesuaikan warna dan mengontrol intensitas
cahaya lampu latar: Fungsi ini akan secara dinamis
menyempurnakan kontras untuk pengalaman
hiburan yang luar biasa saat menonton video atau
menjalankan permainan.

3.2 Philips SmartControl Lite

Perangkat lunak SmartControl Lite baru dari
Phillips memungkinkan Anda mengontrol monitor
melalui antarmuka grafis layar yang mudah
digunakan. Penyesuaian rumit sebelumnya kini
tidak ada lagi karena panduan perangkat lunak
yang mudah digunakan ini akan memandu Anda
menyesuaikan resolusi penyempurnaan, Kalibrasi
warna, Pengaturan jam/fase, Pengaturan titik putih
RGB, dsb.

Dengan dilengkapi teknologi algoritme inti
terbaru untuk pemrosesan serta respons yang
cepat, perangkat lunak berbasis lkon animasi
yang menarik dan mendukung Windows 7

ini siap menyempurnakan pengalaman Anda
menggunakan monitor Philips!

El Penginstalan

* lkuti petunjuk dan selesaikan penginstalan.

* Anda dapat mengaktifkannya setelah
penginstalan selesai.

» Jika ingin mengaktifkannya di lain waktu, Anda
dapat mengklik cara pintas di desktop atau
toolbar

PHILIPS

Monitor driver and software installation




Wizard pengaktifan pertama kali

Setelah penginstalan SmartControl Lite selesai,
Wizard pengaktifan pertama kali akan terbuka

secara otomatis.

Wizard ini akan memandu Anda menyesuaikan

performa monitor secara bertahap.
Menu Plug-in juga dapat dibuka untuk
menjalankan wizard di lain waktu.

Anda dapat menyesuaikan pilihan lainnya tanpa
menggunakan wizard melalui panel Standard

(Standar) .

8 smartcontol

SmartControl Lite

i

Adjust Audo

Auto Prot

i

Color

w

Presats

L R

Help

Muki Monitors

2- Philps 22581 (CS30715000001) (2)(X)
PHILIPS

Wizard

Youlneed to calbrate your display to get the most
accurate color. We encourage you to use the smple
tuning process by selecting the Start Wiza
“This roces fvokes a sers of s that wi KEyou
tune your diplay and save the settings.

1. Choose the Start Wizard button.

2. Folow the steps outined i ths process.
3. Save your settings for future use.

Start Wiard

E1 Memulai dengan panel Standard (Standar):

Menu Adjust (Penyesuaian):

*  Menu Adjust (Penyesuaian) digunakan untuk
menyesuaikan Brightness (Kecerahan),
Contrast (Kontras), Focus (Fokus), Position
(Posisi), dan Resolution (Resolusi).

* Anda dapat mengikuti petunjuk dan melakukan

penyesuaian.

*  Cancel (Batal) mengkonfirmasi pengguna jika
ingin membatalkan penginstalan.

8 smanontol

SmartControl Lite

]

Adjust

i
i
i

S

g

g q

Posttion
Options

®»

Resolution

&

Help

8 smantcontol

SmartControl Lite

Brghtness

P

Contrast

Color
&

a @

Q

Positon

Options. o

Resolution

®

Help

10

2 - Philps 22581 (CS30715000001) (2%,
PHILIPS

Brightness

Improperly adjusted Brightness wil resuft n a loss of
arker image areas. Adjust the Brightness for
ossible picture qualty.

1. Lower the Brightness to the minimum level,
2. Raise the Brightness o the desred level

3. Adjust the Brightness as needed to achieve
an equal separation of the strpes.

Brightness 100

o+

undo Reset.

2.- Philps 22581 (C$30715000001) [¥]\%)
PHILIPS

Contrast

Adjust the Contrast (use the slder) to keep detals in
lghter image areas.
1. Raise the Contrast unti the numbers 1 and 2
are no longer visble.
2. Slowly lower the Contrast to make the
numbers 2 and 3 reappear. The number 1
should remain barely visble.

Contrast 50
= +

Undo Reset




L 2oz (comisnmoony) (0 Menu Color (Warna):

SmartControl Lite PHILIPS *  Menu Color (Warna) digunakan untuk
Focus menyesuaikan RGB, Black Level (Tingkat
st o e smaenesd wen Hitam), White Point (Titik Putih), Display

1. Goote Auto seup
e Gamma (Gamma Tampilan), Color Calibration

Pitch: Try to make the vertical bands disappear.

) Phase: st he bhiet st o mance (Kalibrasi Warna), dan Smartlmage Lite (Lihat

e bagian Smartimage Lite).
* Anda dapat mengikuti petunjuk dan melakukan

A - . :
: S o @ penyesuaian.
Focus Phase 17 . .
o0 * *  Untuk item submenu berdasarkan input Anda,

Options

P
;; ww | awoses lihat tabel di bawah ini.
*  Misalnya Color Calibration (Kalibrasi Warna).

Resolution

B smartControl 2- Philps 22581 (€530715000001) {2} %)

SmartControl Lite PHILIPS

RGB
Al diplayed colors are produced by mixing Red, ¢ e,

- 2nd Croan t dffrant bightnesslveks. Choo
8 Smanconol 2 hips 22581 (csa0715000001) (210 Reize W Por wi e v optre RGB.  you

prefer to adjust the RGB now, folow these steps:
SmartControl Lite PHILIPS

1. Adjust the intensty of the Red, Green, and
Bue using the sider bars.
NOTE: Ghanging the RGB values an adversely effect
the displayed colors.

Adiust
Use the Position buttons to center the image on - a
your display. Usng this tool, you can postion the image

Position
!
up, down, e, or rght. Black Level o P
1. Use the Up/Down buttons to center the image - 160
verticaly.
2. Use the Left/Right buttons to center the image Color White Point =] o
horizontally.
Ble 100
Adiust a “
7 Display Gamma. = Cw
Brightness 3
undo Reset
Options Calibration
Contrast
.
Color AR . @
ol Smartimage
- Focus
_ s
Hep
Podtion
Options. Undo Reset.

Resolution

((] 8 Smartcontrol 2.-Philps 22581 (c530715000001) (F]X)

(+] SmartControl Lite PHILIPS

Help

White Point

White Point i the point at which equal combinations
= of red, green, and biue kght at ful intensiy create
8 smartcontrol 2- Philps 22581 (CS30715000001) (F)\X) white. This effects the overal color quaky. For the

S Sk o ek i Wk Wt i
SmartControl Lite PHILIPS

select the White Pont.
1. Please select the White Point value for the best

W possble color quakty.
Resolution ! e
Youarecurenty t» prfemed resslton.Fryour —
y to show crp, car tex, colrs, and mages,
your dsplay should be s to s Preferred resoluton. ) L2l
IF your deply s at 2 Non-Preferred resoluton, cick %
on the Preferred button to change your resolton to Color v Pont
Preferred
- Whte point G500k
Adjust I Enable Resolution Notfier K Eo
¥ Display Gamma = O &
arghtness picture Format X
— ™ 4:3 aspect rato
" ! undo Reset
Options Galbration e\ Remt
Contrast
ap
Color - > 4
A Smartimage
- Foaus
= .
.’- Help
Postion
o prefered
\g - HWHH““H‘H“HH““HH““HH“HH

L

11



8 smartcontol

SmartControl Lite

U
Adiost ]
— it
Cobr whe Pont
I Depiy Gamra
o -l
Options Golbrton
- ap
smartinage
Help

8 smartcontrol

SmartControl Lite

ea
White Point

Display Gamma

-

ap

Smartimage

sade

2-Philps 225B1 (CS30715000001) (2)(X)

PHILIPS

Display Gamma

Gamma is a component of the pixel brightness in
diplay. A lower Gamma value produces brighter pixels
and a higher Gamima value produces darker pixek. The
defaut vaive for Gamma s 2.2.

To adjust Gamma, Smartimage must be set to Off.
Cick the Smartimage Off button before adjusting

1. Use the sider to select the desred Gamma.

Oply Gamma 22
=] O &
Smartimage OFF
undo Reset

2- Philps 22581 (cs30715000001) {Z)1)

PHILIPS

Calibration

Your display needs to be properl calibrated in order
for o produce the widest range of colors accurately.
Calibration should abways take piace as the st tuning
step i the process. Remember to recalbrate any tme
you make ndwidual adjustments to iage qualty or
whenever you move your display to a new location.

. Make al other necessary adjustments to image
quaity fist.
Press Show Me to lear how to use the

aal n toos.
Finaly, press Start to begin the calibration
process.

¥ Enable color calbration

Color software designed in colaboration with Joseph
Holmes.

Protected by U.S. Patent No. 6,686,953

Show Me start

Quick View.

"Show Me" (Tunjukkan) memulai tutorial

kalibrasi warna.

Start (Mulai) - memulai urutan kalibrasi

warna 6 langkah.

Quick View (Tampilan Ringkas) memuat
gambar sebelum/sesudah kalibrasi.

Untuk kembali ke panel awal Color (Warna),

klik tombol Cancel (Batal).

Enable color calibration (Aktifkan kalibrasi
warna) - telah diaktifkan secara default. Jika
tidak dicentang, kalibrasi warna tidak dapat
dijalankan serta tombol mulai dan tampilan
ringkas akan dinonaktifkan.

Info paten harus ditampilkan di layar kalibrasi.

Layar Kalibrasi warna pertama:

*  Tombol Previous (Sebelumnya) dinonaktifkan
hingga layar kalibrasi warna kedua ditampilkan.

*  Next (Berikutnya) menampilkan layar sesuai
urutan selanjutnya (6 target).

* Layar terakhir menampilkan panel File>Presets
(File>Preset).

»  Cancel (Batal) menutup antarmuka pengguna
dan kembali ke halaman plug in.



Options>Preferences (Pilihan>Preferensi) - .
Hanya diaktifkan sewaktu memilih Preferences
(Preferensi) dari menu drop-down Options

(Pilihan). Di layar yang tidak didukung, namun
dilengkapi DDC/CI, hanya tab Help (Bantuan) dan
Options (Pilihan) yang tersedia.

8 smartControl 2- Philps 22581 (CS30715000001) \2)(X

SmartControl Lite PHILIPS

Preferences

&
g Q

Adjust. Audo

Run at Startup (Jalankan Saat Pengaktifan)
dicentang (Aktif) secara default. Bila
dinonaktifkan, SmartControl Lite tidak akan
berjalan saat pengaktifan atau tidak akan
ditampilkan dalam baki tugas. Satu-satunya cara
menjalankan SmartControl Lite adalah melalui
cara pintas desktop atau file program. Preset
apapun yang ditetapkan untuk berjalan saat
pengaktifan tidak akan dimuat bila kotak ini
tidak dicentang (Dinonaktifkan).

Enable transparency mode (Aktifkan mode
transparansi) (Windows 7,Vista, XP). Nilai
default adalah 0% Tidak Tembus Cahaya.

\? "y Options>Input (Pilihan>Input) - Hanya diaktifian
N k sewaktu memilih Input dari menu drop-down
\% ‘;’“ Options (Pilihan). Di layar yang tidak didukung,
i namun dilengkapi DDC/CI, hanya tab Help
\g woncs (Bantuan) dan Options (Pilihan) yang tersedia.
= Semua tab SmartControl Lite lainnya tidak
tersedia.
B8 smartControl 2 - Philps 22581 (C530715000001) {F}X)
» Menampilkan pengaturan preferensi saat ini. SmartControl Lite PHILIPS

* Jika kotak dicentang, fitur akan diaktifkan. Kotak
centang berfungsi sebagai pengunci.

*  Enable Context Menu (Aktifkan Menu
Konteks) di desktop dicentang (Aktif) secara
default. Enable Context Menu (Aktifkan Menu
Konteks) menampilkan pilihan Select Preset
(Pilih Preset) dan Tune Display (Sempurnakan
Layar) untuk SmartControl Lite dalam menu
konteks klik kanan di desktop. Disabled
(Dinonaktifkan) menghapus SmartControl Lite
dari menu konteks klik kanan tersebut.

* lkon Enable Task Tray (Aktifkan Baki Tugas)
dicentang (Aktif) secara default. Aktifkan
menu konteks menampilkan menu baki tugas
untuk SmartControl Lite. Mengklik kanan *
ikon baki tugas akan menampilkan pilihan
menu Help (Bantuan), Technical Support y
(Dukungan Teknis), Check for Update (Periksa
Pembaruan), About (Tentang), dan Exit
(Keluar). Bila Enable task tray menu (Aktifkan
menu baki tugas) dinonaktifkan, ikon baki tugas
hanya akan menampilkan EXIT (KELUAR).
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Adjust Aud

i
L

Color Input.

W ie

Options Presets

4
%

Help

Analog In Digital In

Menampilkan panel petunjuk Source (Sumber)
dan pengaturan sumber input saat ini.

Di layar input tunggal, panel ini tidak akan
ditampilkan.



Options>Audio (Pilihan>Audio) - Hanya
diaktifkan sewaktu memilih Audio dari menu drop-
down Options (Pilihan).

Di layar yang tidak didukung, namun dilengkapi
DDC/CI, hanya tab Help (Bantuan) dan Options
(Pilihan) yang tersedia.

8 smartcontrol 2- Philps 22581 (CS30715000001) (2%

SmartControl Lite PHILIPS

Audio

Adjust the Volume of the Integrated loudspeakers by
usig the sider.

Tum off the integrated loudspeakers by checking the
Mute checkbox.

Q ™ mute
Adjust

Audio

i

Auto Pt

\g -
Color Input
— . B
@ )
2
Options e
\Q Mot Maitors
voum 100
Hep =

undo

Help>User Manual (Bantuan>Panduan Pengguna)
- Hanya diaktifkan sewaktu memilih User Manual
(Panduan Pengguna) dari menu drop-down Help
(Bantuan). Di layar yang tidak didukung, namun
dilengkapi DDC/CI, hanya tab Help (Bantuan) dan
Options (Pilihan) yang tersedia.

B SmartControl 2 - Phiips 22581 (CS30715000001) (2)(X,

SmartControl Lite PHILIPS

User Manual

1f you need help satting up or operating SmartContol,
cick the Tech. Support
option to fil out an Assst

3

You can ako choose to have ifc
software automaticaly attach; e assstance
form. You'l need to be onine to use this feature.

i

Adjust
User Manual
7
Uptate
Color
. oy D
=
\g spmD
Options
x5

Version

)

User Manual Tech. Support

Help>Version (Bantuan>Versi) - Hanya diaktifkan
sewaktu memilih Version (Versi) dari menu drop-
down Help (Bantuan). Di layar yang tidak didukung,
namun dilengkapi DDC/CI, hanya tab Help
(Bantuan) dan Options (Pilihan) yang tersedia.

B SmartControl 2- Philps 22581 (C530715000001) {2\

SmartControl Lite PHILIPS

Version

VALUATION dtune-p-R2009-12-17-

DDC/CI Communication: Yes - ATI2 APT

Copyright © 1993-2008 Portrakt Displays, Inc.

]

Adjust

User Manual

P
®
Update
Color
a
3 Dispby 1D
2N
System D
Options
Verson

®

Menu Sesuai Konteks

Context Sensitive Menu (Menu Sesuai Konteks)
diaktifkan secara default. Jika Enable Context Menu
(Aktifkan Menu Konteks) telah dicentang dalam
panel Options>Preferences (Pilihan>Preferensi),
menu tersebut akan ditampilkan.

@ SmartControl
Select Preset 3
Tune Display




Menu Konteks memiliki empat entri:

SmartControl Lite - Bila dipilih, About Screen
(Tentang Layar) akan ditampilkan.

Select Preset (Pilih Preset) - Memberikan
urutan menu preset yang disimpan untuk
digunakan di lain waktu. Tanda centang
menunjukkan preset yang saat ini dipilih. Preset
Pabrik juga dapat dipilih dari menu drop down.
Tune Display (Sempurnakan Layar) - Membuka
panel kontrol SmartControl Lite.

Smartlmage Lite - Memeriksa pengaturan saat
ini, seperti Standard (Standar), Internet, dan
Game (Permainan).

Menu Baki Tugas Diaktifkan

Menu baki tugas dapat ditampilkan dengan
mengklik kanan ikon SmartControl Lite dari baki
tugas. Klik kiri akan mengaktifkan aplikasi.

Help

Technical Support
Check for Update
About

Exik

Baki tugas memiliki lima entri:

* Help (Bantuan) - Mengakses file User Manual
(Panduan Pengguna): Buka file User Manual
(Panduan Pengguna) menggunakan jendela
browser default.

Technical Support (Dukungan Teknis) -
Menampilkan halaman dukungan teknis.
Check for Update (Periksa Pembaruan) -
Mengarahkan pengguna ke Arahan PDI dan
memeriksa versi pengguna terhadap versi
terbaru yang tersedia.

About (Tentang) - Menampilkan informasi rinci
tentang referensi: versi produk, informasi edisi,
dan nama produk.

Exit (Keluar) - Menutup SmartControl Lite.
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Untuk kembali menjalankan SmartControl Lite,
pilih SmartControl Lite dari menu Program, lalu
klik dua kali ikon PC desktop, atau hidupkan ulang
sistem.

PHILIPS

SmartControl

‘SmartControl
Version 3.20
dltune-standard-R2007-01-04-1151-23
Copyright 1983-2007 Portrait Displays, Inc.
Pstents Pending

Menu Baki Tugas Dinonaktifkan

Bila Baki Tugas dinonaktifkan dalam folder
preferensi, maka hanya pilihan EXIT (KELUAR)
yang tersedia. Untuk menghapus SmartControl
Lite secara keseluruhan dari baki tugas, nonaktifkan
Run at Startup (Jalankan Saat Pengaktifan) dalam
Options>Preferences (Pilihan>Preferensi).

€ Catatan

Semua ilustrasi dalam bagian ini hanya untuk
referensi.Versi perangkat lunak SmartControl
mungkin diubah tanpa pemberitahuan. Harap selalu
periksa situs web resmi Portrait www.portrait.
com/dtune/phl/enu/index untuk mengunduh versi
terbaru perangkat lunak SmartControl.-



4. Spesifikasi Teknis

Jenis panel monitor LCDTFT

Lampu latar CCFL (220V3/220V3A), LED (220V3L/220V3LA)
Ukuran panel 22" (55,9 cm)

Rasio aspek 16:10

Jarak Piksel 0,282 x 0,282 mm

Kecerahan 250 cd/m?

SmartContrast 10.000.000:1

Rasio kontras (biasa) 1000:1

Waktu respons (biasa) 5ms

Resolusi Optimum

1680x1050 pada 60Hz

Sudut pandang

160° (H) / 160° (V) pada C/R>10

Input sinyal

Warna layar 16,7 M
Kecepatan refresh vertikal 56Hz-76Hz
Frekuensi Horizontal 30kHz - 83kHz
sRGB YA

DVI-D (digital),VGA (Analog)

Sinyal Input

Kenyamanan Pengguna

Sinkronisasi Terpisah, Sinkronisasi pada Nyala Hijau

AO/Y /A O/4 /K O

(220V3/220V3L)

Kenyamanan Pengguna AUTO /¥ (/A O /4 /0K 0)
(220V3A/220V3LA)

Bahasa OSD Inggris, Prancis, Jerman, Italia, Rusia, Spanyol, China Modern,

Portugis, Turki

Kenyamanan lainnya

Kunci Kensington

Kompatibilitas Plug & Play

Kemiringan

DDC/CI, sRGB, Windows 7, Mac OSX, Linux

-5/+20
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Mode Aktif

22,63W (biasa), 26,5TW (maks.)

Pemakaian Daya

Tegangan Input AC

Tegangan Input AC

Tegangan Input AC

(Metode pengujian pada 100VAC +/-5VAC| pada 115VAC +/-5VAC] pada 230VAC +/-5VAC

EnergyStar 5.0) 50Hz +/- 5Hz 50Hz +/- 5Hz 50Hz +/- 5Hz

Pengoperasian Normal| 20,61W 201W 19,85W

(biasa)

Tidur (Siaga) 0,5W 0,5W 0,5W

Tidak Aktif 0,5W 0,5W 0.5W

Penghilangan Panas* Tegangan Input AC Tegangan Input AC Tegangan Input AC
pada 100VAC +/-5VAC| pada 115VAC +/-5VAC]| pada 230VAC +/-5VAC
50Hz +/- 5Hz 50Hz +/- 5Hz 50Hz +/- 5Hz

Pengoperasian Normal

70,35 BTU/jam

69,67 BTU/jam

67,75 BTU/jam

Tidur (Siaga) 1,706 BTU/jam 1,706 BTU/jam 1,706 BTU/jam
Tidak Aktif 1,706 BTU/jam 1,706 BTU/jam 1,706 BTU/jam
Indikator LED Daya Mode Aktif: Putih, Siaga/Tidur: Putih (Berkedip)

Catu Daya Internal, 100-240VAC, 50-60Hz

Mode Aktif 21,41W (biasa), 31,9W (maks.)

Pemakaian Daya

Tegangan Input AC

Tegangan Input AC

Tegangan Input AC

(Metode pengujian pada 100VAC +/-5VAC| pada 115VAC +/-5VAC] pada 230VAC +/-5VAC

EnergyStar 5.0) 50Hz +/- 5Hz 50Hz +/- 5Hz 50Hz +/- 5Hz

Pengoperasian Normal| 20,00W 19,79W 19,50W

(biasa)

Tidur (Siaga) 0,5W 0,5W 0,5W

Tidak Aktif 0,5W 0,5W 0,5W

Penghilangan Panas* Tegangan Input AC Tegangan Input AC Tegangan Input AC
pada 100VAC +/-5VAC] pada 115VAC +/-5VAC] pada 230VAC +/-5VAC
50Hz +/- 5Hz 50Hz +/- 5Hz 50Hz +/- 5Hz

Pengoperasian Normal

68,25 BTU/jam

67,54 BTU/jam

66,55 BTU/jam

Tidur (Siaga) 1,706 BTU/jam 1,706 BTU/jam 1,706 BTU/jam
Tidak Aktif 1,706 BTU/jam 1,706 BTU/jam 1,706 BTU/jam
Indikator LED Daya Mode Aktif: Putih, Siaga/Tidur: Putih (Berkedip)

Catu Daya Internal, 100-240VAC, 50-60Hz
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Mode Aktif

19,59W (biasa), 24,15W (maks.)

Pemakaian Daya

Tegangan Input AC

Tegangan Input AC

Tegangan Input AC

(Metode pengujian pada 100VAC +/-5VAC| pada 115VAC +/-5VAC] pada 230VAC +/-5VAC

EnergyStar 5.0) 50Hz +/- 5Hz 50Hz +/- 5Hz 50Hz +/- 5Hz

Pengoperasian Normal | 16,72W 16,49W 16,24W

(biasa)

Tidur (Siaga) 0,5W 0,5W 0,5W

Tidak Aktif 0,5W 0,5W 0,5W

Penghilangan Panas* Tegangan Input AC Tegangan Input AC Tegangan Input AC
pada 100VAC +/-5VAC| pada 115VAC +/-5VAC] pada 230VAC +/-5VAC
50Hz +/- 5Hz 50Hz +/- 5Hz 50Hz +/- 5Hz

Pengoperasian Normal

57,08 BTU/jam

56,26 BTU/jam

55,42 BTUfjam

Tidur (Siaga) 1,706 BTU/jam 1,706 BTU/jam 1,706 BTU/jam
Tidak Aktif 1,706 BTU/jam 1,706 BTU/jam 1,706 BTU/jam
Indikator LED Daya Mode Aktif: Putih, Siaga/Tidur: Putih (Berkedip)

Catu Daya Internal, 100-240VAC, 50-60Hz

Mode Aktif 18,54W (biasa), 28,03W (maks.)

Pemakaian Daya

Tegangan Input AC

Tegangan Input AC

Tegangan Input AC

(Metode pengujian pada 100VAC +/-5VAC| pada 115VAC +/-5VAC] pada 230VAC +/-5VAC

EnergyStar 5.0) 50Hz +/- 5Hz 50Hz +/- 5Hz 50Hz +/- 5Hz

Pengoperasian Normal| 16,33W 16,19W 16,05W

(biasa)

Tidur (Siaga) 0,5W 0,5W 0,5W

Tidak Aktif 0,5W 0,5W 0,5W

Penghilangan Panas* Tegangan Input AC Tegangan Input AC Tegangan Input AC
pada 100VAC +/-5VAC] pada 115VAC +/-5VAC] pada 230VAC +/-5VAC
50Hz +/- 5Hz 50Hz +/- 5Hz 50Hz +/- 5Hz

Pengoperasian Normal

55,72 BTU/jam

55,26 BTU/jam

54,79 BTU/jam

Tidur (Siaga) 1,706 BTU/jam 1,706 BTU/jam 1,706 BTU/jam
Tidak Aktif 1,706 BTU/jam 1,706 BTU/jam 1,706 BTU/jam
Indikator LED Daya Mode Aktif: Putih, Siaga/Tidur: Putih (Berkedip)

Catu Daya Internal, 100-240VAC, 50-60Hz
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Produk dengan dudukan (PxLxT)

530 x 425 x 213 mm

Produk tanpa dudukan (PxLxT)

530 x 364 x 53 mm

Produk dengan dudukan 3,81 kg
Produk tanpa dudukan 3,51 kg
Produk dengan kemasan 4,32 kg

Kisaran suhu (beroperasi)

0°C hingga 40°C

Kisaran suhu (tidak beroperasi)

-20°C hingga 60°C

Kelembaban relatif

20% hingga 80%

Ketinggian beroperasi: + 12.000 kaki (3.658 m)
tidak beroperasi: + 40.000 kaki (12.192 m)
MTBF 30.000 jam
| Lingwngan ]
ROHS YA
EPEAT Perak. (www.epeat.net)
EnergyStar 5.0 (hanya untuk model tertentu)
Kemasan 100% dapat didaur ulang
Zat Khusus Casing bebas PVC BFR

Pengesahan Peraturan

Warna

Tanda CE, FCC Kelas B, GOAST, SEMKO, TCO Certified, UL/cUL,
BSMI, 1ISO9241-307, Energy star 5.0

Hitam

Lapisan Luar

Mengkilap/Bertekstur

© Catatan
EPEAT Emas atau Perak hanya berlaku di lokasi tempat produk Philips terdaftar Untuk status
registrasi di negara Anda, kunjungi www. epeat.net.

Informasi ini dapat berubah tanpa pemberitahuan sebelumnya. Untuk men-download selebaran versi

terbaru, kunjungi www.philips.com/support.
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4.1 Mode Resolusi & Preset

El Resolusi Maksimum

1680 x 1050 pada 60 Hz (input analog)
1680 x 1050 pada 60 Hz (input digital)

E1 Resolusi yang Disarankan

1680 x 1050 pada 60 Hz (input digital)

[Frek H.(kHz) | Resolusi [ Frek.V.(Hz) |
31,469 640x350 70,086
31,469 720x400 70,086
31,469 640x480 59,940
35,000 640x480 67,000
37,500 640x480 75,000
35156 800x600 56,250
37,879 800x600 60,317
46,875 800x600 75,000
48,363 1024x768 60,004
60,023 1024x768 75,029
63,981 1280x1024 60,020
79976 1280x1024 75,025
55,469 1440x900 59,901
55,935 1440x900 59,887
70,635 1440x900 74,984
65,290 1680x1050 60,000
82,306 1680x1050 74,892

© Catatan

Perhatikan bahwa tampilan berfungsi dengan paling
baik pada resolusi aslinya yaitu 1680 x 1050 pada
60Hz. Untuk kualitas tampilan terbaik, ikuti resolusi
yang rekomendasi ini.
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5.Manajemen Daya

5.1 Hemat Daya Otomatis

Jika PC dilengkapi perangkat lunak yang terinstal
atau kartu tampilan yang terpasang sesuai dengan
DPMVESA, monitor secara otomatis dapat
mengurangi pemakaian daya saat tidak digunakan.
Jika terdapat input dari keyboard, mouse, atau
perangkat input lainnya yang terdeteksi, monitor
akan 'bangun' secara otomatis. Tabel berikut
menunjukkan pemakaian daya dan pemberian
sinyal dari fitur hemat daya otomatis ini:

220V3
Mode | Video [Sinkronisasi|Sinkronisasi Daya yang Warna
VESA horizontal | vertikal Digunakan LED
Aktif | AKTIF Ya Ya <22,63W (biasa)| Putih
< 2651 W (maks)
Tidur | TIDAK Tidak Tidak <05W (biasa) Putih
(Siaga) | AKTIF (berkedip)
Matikan | TIDAK - - <0,5W (biasa) TIDAK
AKTIF AKTIF
220V3A
Mode | Video |Sinkronisasi|Sinkronisasi Daya yang Warna
VESA horizontal | vertikal Digunakan LED
Aktif | AKTIF Ya Ya <2141W (biasa)| Putih
< 319W (maks.)
Tidur | TIDAK | Tidak Tidak <0,5W (biasa) Putih
(Siaga) | AKTIF (berkedip)
Matikan | TIDAK - - <0,5W (biasa) TIDAK
AKTIF AKTIF
220V3L
Mode | Video |Sinkronisasi|Sinkronisasi Daya yang Warna
VESA horizontal | vertikal Digunakan LED
Aktif | AKTIF Ya Ya <1959W (biasa)| Putih
< 2415W (maks.)
Tidur | TIDAK | Tidak Tidak <0,5W (biasa) Putih
(Siaga) | AKTIF (berkedip)
Matikan [ TIDAK - - <0,5W (biasa) TIDAK
AKTIF AKTIF

220V3LA

Mode | Video |Sinkronisasi|Sinkronisasi Daya yang Warna
VESA horizontal | vertikal Digunakan LED

Aktif | AKTIF Ya Ya <1854 W (biasa)| Putih

< 28,03 W (maks.)

Tidur | TIDAK Tidak Tidak <0,5W (biasa) Putih
(Siaga) | AKTIF (berkedip)
Matikan [ TIDAK - - <0,5W (biasa) TIDAK

AKTIF AKTIF

Berikut adalah konfigurasi yang digunakan untuk
menghitung pemakaian daya pada monitor.

Resolusi asli: 1680 x 1050

Kontras: 50%

Kecerahan: 250 nits

Suhu warna: 6.500k dengan pola putih sepenuhnya

© Catatan

Informasi ini dapat berubah tanpa pemberitahuan
sebelumnya.
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6. Informasi Peraturan

Lead-free Product

Lead free display promotes
environmentally sound recovery and
disposal of waste from electrical and
electronic equipment. Toxic substances
like Lead has been eliminated and compliance
with European community’s stringent RoHs
directive mandating restrictions on hazardous
substances in electrical and electronic equipment
have been adhered to in order to make Philips
monitors safe to use throughout its life cycle.

Congratulations,
Your display is designed for both you and the

planet!
CERTIFIED
is designed, manufactured and
tested according to some of the
strictest quality and environmental requirements
in the world. This makes for a high performance
product, designed with the user in focus that also
minimizes the impact on the climate and our
natural environment.

The display you have just purchased
carries the TCO Certified label.
This ensures that your display

TCO Certified is a third party verified program,
where every product model is tested by an
accredited impartial test laboratory. TCO
Certified represents one of the toughest
certifications for displays worldwide.

Some of the Usability features of the TCO
Certified for displays:

* Visual ergonomics for good image quality
is tested to ensure top performance and
reduce sight and strain problems. Important
parameters are luminance, contrast, resolution,
black level, gamma curve, colour and luminance
uniformity and colour rendering

* Products are tested according to rigorous safety
standards at impartial laboratories

* Electric and magnetic fields emissions as low as
normal household background levels

* Low acoustic noise emissions (when applicable)

Some of the Environmental features of the TCO
Certified for displays:

* The brand owner demonstrates corporate
social responsibility and has a certified
environmental management system (EMAS or
ISO 14001)

* Very low energy consumption both in on- and

standby mode minimize climate impact

Restrictions on chlorinated and brominated

flame retardants, plasticizers, plastics and heavy

metals such as cadmium, mercury and lead

(RoHS compliance)

* Both product and product packaging is prepared
for recycling

* The brand owner offers take-back options

The requirements can be downloaded from our
web site. The requirements included in this label
have been developed by TCO Development in
co-operation with scientists, experts, users as well
as manufacturers all over the world. Since the end
of the 1980s TCO has been involved in influencing
the development of IT equipment in a more user-
friendly direction. Our labeling system started with
displays in 1992 and is now requested by users
and [Tmanufacturers all over the world. About
50% of all displays worldwide are TCO certified.

For more information, please visit
www.tcodevelopment.com

For displays with glossy bezels the user should
consider the placement of the display as the bezel
may cause disturbing reflections from surrounding
light and bright surfaces.
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EPEAT
(www.epeat.net)

“The EPEAT (Electronic Product
Environmental Assessment Tool)
program evaluates computer
desktops, laptops, and monitors
based on 571 environmental criteria developed
through an extensive stakeholder consensus
process supported by US EPA.

EPEAT system helps purchasers in the public
and private sectors evaluate, compare and select
desktop computers, notebooks and monitors
based on their environmental attributes. EPEAT
also provides a clear and consistent set of
performance criteria for the design of products,
and provides an opportunity for manufacturers to
secure market recognition for efforts to reduce
the environmental impact of its products.”

X
Q:b

X

Benefits of EPEAT

Reduce use of primary materials

Reduce use of toxic materials

Avoid the disposal of hazardous waste EPEAT’S
requirement that all registered products meet
ENERGY STAR's energy efficiency specifications,
means that these products will consume less
energy throughout their life.

CE Declaration of Conformity

This product is in conformity with the following
standards

EN60950-1:2006 (Safety requirement of
Information Technology Equipment)
EN55022:2006 (Radio Disturbance
requirement of Information Technology
Equipment)
EN55024:1998+A1:2001+A2:2003 (Immunity
requirement of Information Technology
Equipment)

EN61000-3-2:2006 (Limits for Harmonic
Current Emission)
EN61000-3-3:1995+A1:2001+A2:2005
(Limitation of Voltage Fluctuation and Flicker)
following provisions of directives applicable
2006/95/EC (Low Voltage Directive)
2004/108/EC (EMC Directive)
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2005/32/EC (EuP Directive, EC No. 1275/2008
mplementing Directive for Standby and Off
mode power consumption) and is produced
by a manufacturing organization on I1SO9000
level.

The product also comply with the following
standards

1SO9241-307:2008 (Ergonomic requirement,
Analysis and compliance test methods for
electronic visual displays)

GS EK1-2000:2009 (GS mark requirement)
prEN50279:1998 (Low Frequency Electric and
Magnetic fields for Visual Display)

MPR-II (MPR:1990:8/1990:10 Low Frequency
Electric and Magnetic fields)

TCO certified (Requirement for Environment
Labeling of Ergonomics, Energy, Ecology and
Emission, TCO: Swedish Confederation of
Professional Employees) for TCO versions

Energy Star Declaration
(www.energystar.gov)

ol

As an ENERGY STAR® Partner,

we have determined that this
product meets the ENERGY STAR®
guidelines for energy efficiency.

& Note

We recommend you switch off the monitor when
it is not in use for a long time.



Federal Communications Commission (FCC)
Notice (U.S. Only)

© This equipment has been tested and found
to comply with the limits for a Class B digital
device, pursuant to Part 15 of the FCC
Rules. These limits are designed to provide
reasonable protection against harmful
interference in a residential installation. This
equipment generates, uses and can radiate
radio frequency energy and, if not installed
and used in accordance with the instructions,
may cause harmful interference to radio
communications. However, there is no
guarantee that interference will not occur
in a particular installation. If this equipment
does cause harmful interference to radio or
television reception, which can be determined
by turning the equipment off and on, the
user is encouraged to try to correct the
interference by one or more of the following
measures:

« Reorient or relocate the receiving antenna.

* Increase the separation between the
equipment and receiver.

»  Connect the equipment into an outlet on
a circuit different from that to which the
receiver is connected.

»  Consult the dealer or an experienced radio/
TV technician for help.

@ Changes or modifications not expressly
approved by the party responsible for
compliance could void the user's authority to
operate the equipment.

Use only RF shielded cable that was supplied with
the monitor when connecting this monitor to a
computer device.

To prevent damage which may result in fire or
shock hazard, do not expose this appliance to rain
or excessive moisture.

THIS CLASS B DIGITAL APPARATUS MEETS
ALL REQUIREMENTS OF THE CANADIAN
INTERFERENCE-CAUSING EQUIPMENT
REGULATIONS.

FCC Declaration of Conformity

Declaration of Conformity for Products Marked
with FCC Logo,

United States Only

FC

This device complies with Part 15 of the FCC
Rules. Operation is subject to the following two
conditions: (1) this device may not cause harmful
interference, and (2) this device must accept any
interference received, including interference that
may cause undesired operation.
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Commission Federale de la Communication
(FCC Declaration)

© Cet équipement a été testé et déclaré

conforme auxlimites des appareils numériques

de class B,aux termes de l'article 15 Des
regles de la FCC. Ces limites sont concues
de facon a fourir une protection raisonnable

contre les interférences nuisibles dans le cadre

d'une installation résidentielle.
CET appareil produit, utilise et peut émettre

des hyperfréquences qui, si |'appareil n'est pas

installé et utilisé selon les consignes données,

peuvent causer des interférences nuisibles aux

communications radio.
Cependant, rien ne peut garantir I'absence

d'interférences dans le cadre d'une installation

particuliere. Si cet appareil est la cause

d'interférences nuisibles pour la réception des
sighaux de radio ou de télévision, ce qui peut

étre décelé en fermant I'équipement, puis en
le remettant en fonction, |'utilisateur pourrait

essayer de corriger la situation en prenant les

mesures suivantes:

* Reéorienter ou déplacer I'antenne de réception.

*  Augmenter la distance entre I'équipement et
le récepteur

*  Brancher I'éguipement sur un autre circuit que

celui utilisé par le récepteur.
e Demander l'aide du marchand ou d'un
technicien chevronné en radio/télévision.

Toutes modifications n'ayant pas recu
I'approbation des services compétents

en matiére de conformité est susceptible
d'interdire a I'utilisateur I'usage du présent
équipement.

N'utiliser que des cables RF armés pour

les connections avec des ordinateurs ou
périphériques.

CET APPAREIL NUMERIQUE DE LA CLASSE
B RESPECTE TOUTES LES EXIGENCES DU
REGLEMENT SUR LE MATERIEL BROUILLEUR
DU CANADA.
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EN 55022 Compliance (Czech Republic Only)

Thiz devica bakongs to catagory B devices aa described in EM 55022, unless it is spacifi-
cally stated that it is 8 Class A device on the spacification labal. The following applies to
devices in Class A of EM 55022 (radius of protection up to 30 meters). The ussr of tha
davica is obliged o0 tske all steps necessary to remove sources of interference o tela-
communication or other devicss.

Pokud nenl na typovém &tithu poditade uvedeno, Zo spadé do do tfidy A podle EN 55022,
do tficly B podie EN 55022, Pro zafizen! zafazend do thidy A (chranné
30m) podie EN 560122 platf nésledujici. Dojde-li k ruien! tslekomunikadnich nebo

Pnjch zafizeni je ufivatel povinnen prowést takovd opatfgnl, aby rudeni odstranil,




Polish Center for Testing and Certification
Notice

The equipment should draw power from a socket
with an attached protection circuit (a three-
prong socket). All equipment that works together
(computer, monitor; printer; and so on) should
have the same power supply source.

The phasing conductor of the room's electrical
installation should have a reserve short-circuit
protection device in the form of a fuse with a
nominal value no larger than 16 amperes (A).

To completely switch off the equipment, the
power supply cable must be removed from the
power supply socket, which should be located
near the equipment and easily accessible.

A protection mark "B" confirms that the
equipment is in compliance with the protection
usage requirements of standards PN-93/1-42107
and PN-89/E-06251.

Wymagania Polskiego Centrum Badan i Certyfikacji

einc byé pasibane 2 priaads 2 praybgcaonyen obwodem ochronnym (gnisado »
mracuigee 2 soby urcadzenia (komputer, monitor, drukarka) powinmy byé msilane

n rezerwawa achrang
nii 164 (amperio).
vezki kabla

by Eatwa dostipie.

i kolka abwidu achrannegs 2 wiyezki
wiyt preediuzace -yl

e
e enapdowad sig s od greejnikiw @ drddel ciepla. |<\|ulw
cmivw wentylacyjnych. Nuledy unikad kladzensa luinych papierd pod
nsa kampulera W Casmym miggscu bex maliwasc Cyrkulacgi powi-

North Europe (Nordic Countries) Information

Placering/Ventilation

VARNING:

FORSAKRA DIG OM ATT HUVUDBRYTARE
OCH UTTAG AR LATATKOMLIGA, NAR DU
STALLER DIN UTRUSTNING PAPLATS.

Placering/Ventilation

ADVARSEL:

SORG VED PLACERINGEN FOR, AT
NETLEDNINGENS STIK OG STIKKONTAKT ER
NEMT TILGANGELIGE.

Paikka/llmankierto

VAROITUS:

SIJOITA LAITE SITEN, ETTA VERKKOJOHTO
VOIDAAN TARVITTAESSA HELPOSTI
IRROTTAA PISTORASIASTA.

Plassering/Ventilasjon

ADVARSEL:

NAR DETTE UTSTYRET PLASSERES, MA
DU PASSE PA AT KONTAKTENE FOR
ST@MTILF@RSEL ER LETTE A NA.

BSMI Notice (Taiwan Only)

HEZBERESIRE |
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Ergonomie Hinweis (nur Deutschland)

Der von uns gelieferte Farbmonitor entspricht den
in der "Verordnung Uber den Schutz vor Schaden
durch Rontgenstrahlen" festgelegten Vorschriften.

Auf der Rickwand des Gerdtes befindet sich

ein Aufkleber, der auf die Unbedenklichkeit der
Inbetriebnahme hinweist, da die Vorschriften tber
die Bauart von Storstrahlern nach Anlage Ill @ 5
Abs. 4 der Rontgenverordnung erflllt sind.

Damit Ihr Monitor immer den in der Zulassung
geforderten Werten entspricht, ist darauf zu
achten, daf3

1. Reparaturen nur durch Fachpersonal
durchgefihrt werden.

2. nur original-Ersatzteile verwendet werden.

3. bei Ersatz der Bildréhre nur eine bauartgleiche

eingebaut wird.

Aus ergonomischen Grinden wird empfohlen,
die Grundfarben Blau und Rot nicht auf dunklem
Untergrund zu verwenden (schlechte Lesbarkeit
und erhdhte Augenbelastung bei zu geringem
Zeichenkontrast wéren die Folge).

Der arbeitsplatzbezogene Schalldruckpegel nach
DIN 45 635 betrdgt 70dB (A) oder weniger.

ACHTUNG: BEIM AUFSTELLEN
DIESES GERATES DARAUF
ACHTEN, DAB NETZSTECKER UND
NETZKABELANSCHLUB LEICHT
ZUGANGLICH SIND.

A

China RoHS

The People's Republic of China released a
regulation called "Management Methods for
Controlling Pollution by Electronic Information
Products" or commonly referred to as China
RoHS. All products are produced and sold for
China market have to meet China RoHS request.
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7.Layanan pelanggan dan
jaminan

7.1 Kebijakan Cacat Piksel Monitor Panel Datar
Philips

Philips berupaya memberikan produk berkualitas
tertinggi. Kami menggunakan beberapa proses
produksi tercanggih di industri dan menerapkan
kontrol kualitas yang ketat. Namun, cacat piksel
atau subpiksel pada panel monitor TFT yang
digunakan di monitor panel datar terkadang
tidak dapat dihindari. Tidak ada produsen yang
dapat menjamin semua panel akan bebas dari
cacat piksel, namun Philips menjamin bahwa
setiap monitor dengan jumlah cacat yang tidak
dapat diterima akan diperbaiki atau diganti sesuai
dengan jaminan yang berlaku. Pemberitahuan

ini menjelaskan berbagai jenis cacat piksel dan
menentukan tingkat cacat yang dapat diterima
untuk masing-masing jenis tersebut. Untuk
memenuhi syarat dalam mendapatkan perbaikan
atau penggantian sesuai jaminan, jumlah cacat
piksel pada panel monitor TFT harus melampaui
tingkat yang dapat diterima. Misalnya, jumlah cacat
subpiksel pada monitor tidak boleh lebih dari
0,0004%. Philips bahkan selanjutnya menentukan
standar kualitas lebih tinggi untuk jenis atau
kombinasi cacat piksel tertentu yang lebih nyata
dibandingkan dengan yang lainnya. Kebijakan ini
berlaku secara global.

subpixel subpixel

\ oy
il &

Piksel dan Subpiksel

Piksel, atau elemen gambar, terdiri dari tiga
subpiksel dalam warna utama merah, hijau, dan
biru. Kombinasi beberapa piksel akan membentuk
gambar: Bila semua subpiksel pada piksel menyala,
kombinasi ketiga subpiksel berwarna tersebut akan
muncul sebagai satu piksel putih. Bila semua mati,
kombinasi ketiga subpiksel berwarna akan muncul

subpixel

sebagai satu piksel hitam. Kombinasi lainnya dari
subpiksel yang menyala dan mati akan muncul
sebagai satu piksel warna lain.

Jenis Cacat Piksel

Cacat piksel dan subpiksel muncul di layar dalam
berbagai bentuk. Ada dua kategori cacat piksel
dan masing-masing kategori tersebut terdiri dari
beberapa jenis cacat subpiksel.

Cacat Titik Terang

Cacat titik terang muncul sebagai piksel maupun
subpiksel yang selalu terang atau 'menyala’.
Karenanya, titik terang merupakan subpiksel yang
terlihat jelas di layar bila monitor menampilkan
pola gelap. Berikut adalah jenis cacat titik terang:

(€]

Satu subpiksel merah, hijau, atau biru terang

I C

Dua subpiksel terang yang berdekatan:
- Merah + Biru = Ungu

- Merah + Hijau = Kuning

- Hijau + Biru = Cyan (Biru Muda)

Tiga subpiksel terang yang berdekatan (satu piksel
putih)
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€& Catatan

Titik terang merah atau biru harus lebih dari 50
persen lebih terang daripada titik di sekitarnya,
sedangkan titik terang hijau 30 persen lebih terang

daripada titik di sekitarnya. .

Cacat Titik Gelap

Cacat titik gelap muncul sebagai piksel maupun
subpiksel yang selalu gelap atau 'mati'. Karenanya,
titik gelap merupakan subpiksel yang terlihat jelas
di layar bila monitor menampilkan pola terang.
Berikut adalah jenis cacat titik gelap:

Jarak Cacat Piksel

Karena cacat piksel dan subpiksel sejenis yang
saling berdekatan mungkin terlihat lebih nyata,
Philips juga menentukan toleransi untuk jarak cacat
piksel.

I Toleransi Cacat Piksel

Untuk memenuhi syarat dalam mendapatkan
perbaikan atau penggantian karena cacat piksel
selama masa berlaku jaminan, panel monitor TFT
pada monitor panel datar Philips harus memiliki
cacat piksel maupun subpiksel melebihi toleransi
yang tercantum dalam tabel berikut ini.

CACAT TITIK TERANG TINGKAT YANG DAPAT DITERIMA

1 subpiksel terang 3

2 subpiksel terang yang berdekatan 1

3 subpiksel terang yang berdekatan (satu piksel putih) 0

Jarak di antara dua cacat titik terang* >15mm

Total cacat titik terang dari semua jenis 3

1 subpiksel gelap 5 atau lebih sedikit

2 subpiksel gelap yang berdekatan 2 atau lebih sedikit

3 subpiksel gelap yang berdekatan 0

Jarak di antara dua cacat titik gelap™ >15mm

Total cacat titik gelap dari semua jenis 5 atau lebih sedikit

TOTAL CACAT TITIK TINGKAT YANG DAPAT DITERIMA

Total cacat titik terang atau titik gelap dari semua jenis 5 atau lebih sedikit
© Catatan

1 atau 2 cacat subpiksel yang berdekatan = 1 cacat titik
Monitor ini sesuai dengan I1SO 9241-307. (1IS09241-307: Metode pengujian kesesuaian, analisis, dan
persyaratan ergonomis untuk tampilan visual elektronik)
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7.2 Layanan pelanggan dan jaminan

Layanan pelanggan dan jaminan

Untuk informasi rinci tentang cakupan jaminan dan persyaratan dukungan tambahan yang berlaku di
negara Anda, kunjungi situs Web www.philips.com/support. Anda ju ga dapat menghubungi nomor Pusat

Layanan Pelanggan Philips setempat yang tercantum di bawah ini.

Informasi kontak untuk kawasan EROPA BARAT:

Negara ASC Nomor layanan konsumen  Harga
Austria Siemens &S +43 0810 000206 € 0.07
Belgium E Care +32 078 250851 €006
Denmark A-novo +45 3525 8761 Local call tariff
Finland A-novo +358 09 2290 1908 Local call tariff
France A-novo +33 082161 1658 € 0.09
Germany Siemens &S +49 01803 386 853 €0.09
Greece Allman Hellas +30 00800 3122 1223 Free of charge
Ireland Invec Scotland +353 01 601 1161 Local call tariff
Italy A-novo +39 840 320 041 €0.08
Luxembourg E Care +352 26 84 30 00 Local call tariff
Netherlands E Care +31 0900 0400 063 €010
Norway A-novo +47 2270 8250 Local call tariff
Poland Zolter +48 0223491505 Local call tariff
Portugal Eatsa Spain +351 2 1359 1440 Local call tariff
Switzerland A-novo +41 02 2310 2116 Local call tariff
Spain Eatsa Spain +34 902 888 785 €0.10
Sweden A-novo +46 08 632 0016 Local call tariff

United Kingdom

Invec Scotland

+44 0207 949 0069

Local call tariff
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Informasi kontak untuk kawasan EROPA TENGAH DAN TIMUR:

Pusat informasi

Nomor layanan konsumen

Belarus NA IBA +375 17 217 3386
Bulgaria NA LAN Service +359 2 960 2360
Croatia NA Renoprom +385 1 333 0974
Czech Rep. NA Asupport 800 100 697
Estonia NA FUJITSU +372 6519900
NA Serware +36 12426331
Hungary -
NA Profi Service +36 1 814 8080
Latvia NA “ServiceNet LV Ltd. +371 7460399
Lithuania NA UAB "Servicenet" +370 7400088
Romania NA Blue Ridge Intl. +40 21 2101969
S_— NA CPS +7 (495) 645 6746 (for repair)
NA CEEE Partners +7 (495) 645 3010 (for sales)
e fegm NA Kim Tec doo. +381 11 20 70 684
Slovakia NA Datalan Service +421 2 49207155
Slovenia NA PC H.and +386 1 530 08 24
g NA Comel +380 562320045
NA Topaz-Service Company +38 044 245 73 31
Turkey NA Techpro +90 212 444 4 832

Informasi kontak untuk kawasan AMERIKA LATIN:

Negara Pusat informasi Nomor layanan konsumen
Argentina Vermont 0800 3330 856
Brazil Vermont 0800-7254101

Informasi kontak untuk AMERIKA UTARA:

Negara Pusat informasi ~ ASC Nomor layanan konsumen
Canada Supercom Supercom (800) 479-6696
USA. TOS Teleplan (877) 835-1838

Informasi kontak untuk China:

China

Nomor layanan konsumen: 4008 800 008




Informasi kontak untuk kawasan APMEA:

Negara Pusat informasi ASC Nomor layanan konsumen
Australia NA AGOS NETWORK PTY LTD [ 1300 360 386
Bancladesh NA Distributor: Computer Source | 880-2-9141747,9127592
s Ltd (warranty buy-out) 880-2-8128848 / 52
Distributor: Neat Technology
Cambodia NA Pte Ltd (Singapore) (warranty | 855-023-999992
buy-out)
Hong Kong / . Hong Kong:Tel: +852 2619 9639
Macau NA Smart Pixels Technology Ltd. | . -\ Tel. (853)-0800-987
. Tel: 1 800 425 6396
India NA REDINGTON INDIA LTD SMS: PHILIPS 1o 56677
. . . . . Tel: 62 21 75909053, 75909056,
Indonesia NA PT. Gadingsari elektronika Prima 7511530
Israel NA Eastronics LTD 1-800-567000
. After Market Solutions (CE)
Malaysia NA Sdn Bhd 603 7953 3370
Nepal NA Distributor: Syakar Co. Ltd 977-1-4222395
(warranty buy-out)
New Zealand | NA Visual Group Ltd. 0800 657447
Pakistan NA Philips Consumer Service (9221) 273741116
I . (02) 633-4533 to 34,
Philippines NA Glee Electronics, Inc. (02) 637-6559 to 60
Philips Electronics Singapore
Singapore NA Pte Ltd (Philips Consumer Care | (65) 6882 3999
Center)
South Africa NA Sylvara Technologies Pty Ltd 086 0000 888
South Korea [ NA PCS One Korea Ltd. 080-600-6600
Sri Lanka NA no d.|str|butor and/or service
provider currently
PCCW
Taiwan Teleservices FETEC.CO 0800-231-099
Taiwan
Thailand NA Axis Computer System Co,, Ltd. | (662) 934-5498
United Arab 5 AL SHAHD COMPUTER LL.C | 00971 4 2276525
Emirates
. . +84 8 38248007 Ho Chi Minh City
Vietham NA FPT Service Informatic +84 5113562666 Danang City

Company Ltd.

+84 5113.562666 Can tho Province
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8. Mengatasi masalah & Tanya
jawab

8.1 Mengatasi Masalah

Halaman ini menjelaskan tentang masalah yang
dapat diatasi pengguna. Jika masalah terus berlanjut
setelah Anda mencoba solusi berikut, hubungi staf
layanan pelanggan Philips.

E Masalah Umum

Tidak Ada Gambar (LED Daya mati)

* Pastikan kabel daya telah tersambung ke
stopkontak dan ke bagian belakang monitor.
Pastikan terlebih dulu tombol daya di bagian
depan monitor telah berada dalam posisi
OFF (TIDAK AKTIF), lalu tekan ke posisi ON
(AKTIF).

Tidak Ada Gambar (LED Daya Putih)

» Pastikan komputer telah dihidupkan.

Pastikan kabel sinyal telah tersambung dengan
benar ke komputer.

Pastikan pin pada kabel monitor yang
tersambung tidak tertekuk. Jika ya, perbaiki
atau ganti kabel.

Fitur Hemat Daya mungkin diaktifkan

Layar menampilkan

Attention

Check cable connection

Pastikan kabel monitor telah tersambung
dengan benar ke komputer: (Lihat juga
Panduan Ringkas).

Periksa pin yang tertekuk pada kabel monitor.
Pastikan komputer telah dihidupkan.
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Tombol AUTO (OTOMATIS) tidak berfungsi

* Fungsi otomatis hanya berlaku dalam mode
Analog VGA. Jika hasilnya tidak memuaskan,
Anda dapat melakukan penyesuaian manual
melalui menu OSD.

© Catatan
Fungsi Otomatis tidak berlaku dalam mode
Digital DVI karena fungsi tersebut tidak
diperlukan.

Tanda yang tampak seperti asap atau kilatan api

* Jangan lakukan langkah-langkah apapun untuk
mengatasi masalah

Lepaskan segera monitor dari catu daya utama
untuk keselamatan

Hubungi segera staf layanan pelanggan Philips.

El Masalah Gambar

Gambar tidak berada di tengah

*  Atur posisi gambar menggunakan fungsi “Auto”
(Otomatis) dalam Kontrol Utama OSD.

Atur posisi gambar menggunakan Phase/
Clock (Fase/Jam) dalam Setup (Konfigurasi)

di Kontrol Utama OSD. Hal ini hanya berlaku
dalam mode VGA.

Gambar bergetar di layar
» Pastikan kabel sinyal telah tersambung dengan
benar dan kencang ke papan grafis atau PC.

Kelip vertikal muncul di layar

Atur gambar menggunakan fungsi “Auto”
(Otomatis) dalam Kontrol Utama OSD.
Hilangkan baris vertikal menggunakan Phase/
Clock (Fase/Jam) dalam Setup (Konfigurasi)
di Kontrol Utama OSD. Hal ini hanya berlaku
dalam mode VGA.



Kelip horizontal muncul di layar

*  Atur gambar menggunakan fungsi “Auto”
(Otomatis) dalam Kontrol Utama OSD.

* Hilangkan baris vertikal menggunakan Phase/
Clock (Fase/Jam) dalam Setup (Konfigurasi)
di Kontrol Utama OSD. Hal ini hanya berlaku
dalam mode VGA.

Gambar terlihat buram, tidak jelas, atau terlalu

gelap

*  Atur kontras dan kecerahan di OSD (On-
Screen Display).

"Jejak gambar", "efek terbakar", atau "bayangan"

tetap muncul setelah daya dimatikan.

* Tampilan gambar diam atau gambar statis
yang tidak berubah dalam waktu lama dapat
menimbulkan “efek terbakar”, disebut juga
“jejak gambar’” atau “bayangan”, di layar. "Efek

terbakar", "jejak gambar", atau "bayangan”

adalah fenomena umum dalam teknologi panel

monitor. Dalam sebagian besar kasus, “‘efek

terbakar”,"jejak gambar’, atau ‘bayangan” akan

menghilang secara bertahap dalam waktu
tertentu setelah daya dimatikan.

* Aktifkan selalu program screensaver bergerak
bila Anda meninggalkan monitor.

» Aktifkan selalu aplikasi refresh layar berkala jika

Monitor akan menampilkan konten statis yang
tidak berubah.

*  Gejala “efek terbakar”, “jejak gambar”, atau
“bayangan” yang fatal tidak akan hilang
dan tidak dapat diperbaiki. Kerusakan yang
disebutkan di atas tidak tercakup dalam
jaminan.

Gambar tampak berubah. Teks tidak jelas atau

buram.

*  Atur resolusi layar PC ke mode sama seperti
resolusi asli layar yang disarankan monitor.
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Titik hijau, merah, biru, hitam, dan putih muncul

di layar

+ Titik tersisa adalah karakter normal yang
muncul pada liquid crystal yang digunakan
dalam teknologi saat ini. Untuk informasi lebih
rinci, lihat kebijakan piksel.

Lampu “daya hidup” terlalu terang dan

mengganggu

* Anda dapat mengatur lampu “daya hidup”
menggunakan Konfigurasi LED daya dalam
Kontrol utama OSD.

Untuk bantuan lebih lanjut, lihat daftar Pusat
Informasi Konsumen dan hubungi staf layanan
pelanggan Philips.



8.2 Tanya Jawab SmartControl Lite

P1.

Jawab:

P2.

Jawab:

Saya mengganti monitor PC dan
SmartControl Lite menjadi tidak dapat
digunakan.Apa yang harus saya lakukan?

Hidupkan ulang PC dan lihat apakah
SmartControl Lite dapat berfungsi. Jika
tidak, hapus dan instal ulang SmartControl
Lite untuk memastikan driver yang benar
telah diinstal.

SmartControl Lite berfungsi dengan baik
sebelumnya, namun kini tidak lagi. Apa
yang dapat saya lakukan?

Jika tindakan berikut dilakukan, driver

monitor mungkin perlu diinstal ulang.

* Mengganti adapter grafis video

* Memperbarui driver video

* Aktivitas pada OS, misalnya service pack
atau patch

* Jalankan Windows Update serta driver
monitor dan/atau video yang diperbarui

* Boot di Windows dijalankan dengan
monitor dalam kondisi mati atau tidak
tersambung. Untuk mengetahuinya, klik
kanan My Computer (Komputer Saya),

lalu klik Properties->Hardware-> Device

Manager (Properti->Perangkat Keras-
>Manajer Perangkat). Jika "Plug and

Play Monitor" (Monitor Plug and Play)
ditampilkan dalam Monitor, Anda harus
menginstal ulang. Hapus dan instal ulang
SmartControl Lite.
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P3.

Jawab:

P4.

Jawab:

Setelah menginstal SmartControl Lite, bila
tab SmartControl Lite diklik, layar tidak
menampilkan apapun setelah beberapa
saat atau layar menampilkan pesan
kegagalan. Mengapa demikian?

Adapter grafis mungkin tidak kompatibel
dengan SmartControl Lite. Jika adapter
grafis adalah salah satu merek yang
disebutkan di atas, coba download driver
adapter grafis terbaru dari situs Web
perusahaan yang terkait. Instal driver. Hapus
SmartControl Lite, lalu instal ulang sekali
lagi.

Jika tetap tidak berfungsi, kami mohon
maaf bahwa adapter grafis tersebut tidak
didukung. Kunjungi situs Web Philips dan
lihat apakah driver SmartControl Lite
terbaru telah tersedia.

Bila saya mengklik Product Information
(Informasi Produk), hanya sebagian
informasi yang ditampilkan. Mengapa
demikian?

Driver adapter kartu grafis mungkin bukan
merupakan versi terbaru yang sepenuhnya
mendukung antarmuka DDC/CI. Coba
download driver adapter grafis terbaru dari
situs Web perusahaan yang terkait. Instal
driver. Hapus SmartControl Lite, lalu instal
ulang sekali lagi.

Attention

Theft Deterence enabled




P5.

Jawab:

Saya lupa PIN untuk Fungsi Theft
Deterrence (Pencegahan Pencurian).Apa
yang dapat saya lakukan?

Pusat Layanan Philips berhak meminta
identifikasi dan otorisasi resmi untuk
menetapkan kepemilikan monitor.

Perlu diketahui bahwa fungsi pencegahan
antipencurian diberikan sebagai pilihan
yang bebas dan mudah. Mengelola nomor
PIN adalah sepenuhnya tanggung jawab
pengguna, baik perorangan maupun
organisasi, yang membuatnya.

Jika lupa nomor PIN, pusat layanan

Philips dapat membuat ulang PIN untuk
Anda dengan membebankan sejumlah
biaya setelah verifikasi kepemilikan. Perlu
diketahui bahwa aktivitas ini tidak tercakup
dalam persyaratan jaminan standar.
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8.3 Tanya Jawab Umum

P1:

Jawab:

P2:

Jawab:

P3:

Jawab:

Sewaktu memasang monitor; apa yang
harus saya lakukan jika layar menampilkan
"Cannot display this video mode" (Tidak
dapat menampilkan mode video ini)?

Resolusi yang disarankan untuk monitor ini:

1680x1050 pada 60Hz.

* Lepas semua kabel, lalu sambungkan PC
ke monitor yang digunakan sebelumnya.

* Dalam Windows Start Menu (Menu
Mulai Windows), pilih Settings/Control
Panel(Pengaturan/Panel Kontrol) . Dalam
Control Panel Window (Jendela Panel
Kontrol), pilih ikon Display (Tampilan).
Dalam Display Control Panel (Panel
Kontrol Tampilan), pilih tab "Settings"
(Pengaturan). Dalam tab pengaturan,
dalam kotak "desktop area" (area
desktop), gerakkan panel samping ke
piksel 1680x1050.

* Buka "Advanced Properties" (Properti
Lanjutan), atur Kecepatan Refresh ke
60Hz, lalu klik OK.

* Hidupkan ulang komputer lalu ulangi
langkah 2 dan 3 untuk memverifikasi
bahwa PC telah diatur ke 1680x1050
pada 60Hz.

* Matikan komputer, lepas monitor lama,
lalu sambungkan monitor Philips.

* Hidupkan monitor, lalu hidupkan PC.

Berapa kecepatan refresh yang disarankan
untuk Monitor?

Kecepatan refresh yang disarankan untuk
Monitor adalah 60Hz. Jika terdapat
gangguan di layar, Anda dapat mengaturnya
hingga 75Hz untuk mengetahui apakah
gangguan tersebut dapat diatasi.

Apakah yang dimaksud dengan file .inf
dan .icm pada CD-ROM!? Bagaimana cara
menginstal driver (.inf dan .icm)?

Ini adalah file driver untuk monitor. Untuk
menginstal driver, ikuti petunjuk dalam

P4:

Jawab:

P5:

Jawab:

Pé:

Jawab:
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P7:

awab:

panduan pengguna. Komputer mungkin
akan menanyakan driver monitor (file

inf dan .icm) atau disk driver saat Anda
menginstal monitor untuk pertama kalinya.
Ikuti petunjuk tentang cara memasukkan
CD-ROM pendamping yang disertakan
dalam kemasan ini. Driver monitor (file .inf
dan .icm) akan diinstal secara otomatis.

Bagaimana cara mengatur resolusi?

Kombinasi driver grafis/kartu video dan
monitor akan menentukan resolusi yang
tersedia. Anda dapat memilih resolusi yang
diinginkan dalam Panel Kontrol Windows®
dengan “Display properties” (Properti
tampilan).

Bagaimana jika saya salah melakukan
penyesuaian monitor melalui OSD?

Tekan tombol OK lalu pilih "Reset" (Atur
Ulang) untuk menggunakan kembali semua
pengaturan pabrik awal.

Apakah layar monitor antigores?

Secara umum, sebaiknya permukaan
panel tidak mengalami guncangan yang
berlebihan dan terlindungi dari benda
tajam atau tumpul. Sewaktu menangani
monitor, pastikan tidak ada tekanan atau
kekuatan berlebihan yang diberikan pada
sisi permukaan panel. Tindakan ini dapat
mempengaruhi ketentuan jaminan.

Bagaimana seharusnya cara membersihkan
permukaan monitor?

Untuk pembersihan normal, gunakan kain
bersih dan lembut. Untuk pembersihan
secara menyeluruh, gunakan isopropil
alkohol. Jangan gunakan bahan pelarut
lainnya seperti etil alkohol, ethanol, aseton,
hexane, dll.



P8:  Apakah pengaturan warna pada monitor
dapat diubah?

Jawab: Ya. Anda dapat mengubah pengaturan
warna melalui kontrol OSD sesuai
prosedur berikut,

* Tekan "OK" untuk menampilkan menu
OSD (On Screen Display)

* Tekan "Down Arrow" (Panah Bawah)
untuk menggunakan pilihan "Color"
(Warna), lalu tekan "OK" untuk membuka
pengaturan warna. Berikut adalah tiga
pengaturan yang tersedia.

1. Temperatur warna; 2 setelannya adalah
6500K, dan 9300K.

2. sRGB; Ini adalah pengaturan standar
untuk memastikan pertukaran
warna yang benar di antara berbagai
perangkat (misalnya kamera digital,
monitor, printer; pemindai, dll.)

3. User Define (Ditentukan Pengguna);
Pengguna dapat memilih pengaturan
warna sesuai keinginannya dengan
menyesuaikan warna merah, hijau, dan
biru.

€ Catatan:

Penghitungan warna lampu yang dipancarkan

oleh benda tertentu sewaktu sedang dipanaskan.
Penghitungan ini diberikan dalam persyaratan skala
absolut, (derajat Kelvin). Suhu Kelvin lebih rendah
seperti 2004K berwarna merah; suhu lebih tinggi
seperti 9300K berwarna biru. Suhu netral adalah
putih pada 6504K.

P9:  Apakah Monitor dapat disambungkan ke
PC manapun, workstation, atau Mac?

Jawab: Ya. Semua Monitor Philips kompatibel
sepenuhnya dengan PC, Mac, dan
workstation standar. Anda mungkin
memerlukan adapter kabel untuk
menyambungkan monitor ke sistem Mac.
Untuk informasi lebih lanjut, hubungi staf
penjualan Philips.

P10:  Apakah Monitor Philips memiliki fungsi

Plug-and-Play?

Jawab: Ya. Monitor merupakan perangkat Plug-
and-Play yang kompatibel dengan Windows
7/Vista/XP/NT, Mac OSX; Linux

P11:  Apa yang dimaksud dengan Gambar
Menempel, Efek Terbakar, Jejak Gambar,

atau Bayangan pada panel monitor?

Jawab: Tampilan gambar diam atau gambar statis
yang tidak berubah dalam waktu lama
dapat menimbulkan "efek terbakar", disebut
juga "jejak gambar" atau "bayangan", di
layar: "Efek terbakar", "jejak gambar", atau
"bayangan" adalah fenomena umum dalam
teknologi panel monitor. Dalam sebagian
besar kasus, "efek terbakar", "jejak gambar",
atau "bayangan" akan menghilang secara
bertahap dalam waktu tertentu setelah
daya dimatikan.

Aktifkan selalu program screensaver
bergerak bila Anda meninggalkan monitor.
Aktifkan selalu aplikasi refresh layar berkala
jika Monitor akan menampilkan konten

statis yang tidak berubah.

() Peringatan

Gejala "efek terbakar”, "jejak gambar", atau
"bayangan" yang fatal tidak akan hilang dan tidak
dapat diperbaiki. Kerusakan yang disebutkan di atas
tidak tercakup dalam jaminan.

P12: Mengapa Layar tidak menampilkan teks
yang jelas, namun menampilkan karakter

bergerigi?

Jawab: Monitor berfungsi paling baik pada resolusi
asli 1680x1050 pada 60Hz. Untuk tampilan
terbaik, gunakan resolusi ini.
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